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this product. ICP DAS Inc., LTD. reserves the right to change tarual at any time
without notice. The information furnished by ICP DAS Inc. is belieeelde accurate
and reliable. However, no responsibility is assumed by ICP DAS Inc., foF s use,
or for any infringements of patents or other rights of third margsulting from its

use.

Copyright and Trademark | nformation
© Copyright 2010 by ICP DAS Inc., LTD. All rights reserved worldwide.

Trademark of Other Companies

The names used for identification only maybe registered tradencaritseir

respective companies.

License

The user can use, modify and backup this software on a single maiéneser
may not reproduce, transfer or distribute this software, orcapy, in whole or in

part.
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SMS Database System Quick Start

1 Product Overview
The purpose of this document is to describe the procedure for using the SMS

Database System. The SMS Database System is a software tool proviG&d4&S
that stores SMS messages in database. Along with hardware provided by 8CP DA
GT-530 (intelligent SMS transmitter) and GTM-201 (GPRS/ GSM Modem)pival
users to view SMS messages sent by GT-530 immediately or to retrigve late

Features:

® Supports MS SQL Server and MS Access 2003 database

® Provides backup mechanism in local site:
when experiencing unexpected disconnection and not able to transmit and
store data in remote SQL Server database, the data will be safely kept in
local site.

® Allows to view real-time or historical data

2 Before Installation
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Before performing software installation, please configure GT-530/ QUM-
hardware and set up the system (Figure above shows a possible system
configuration. For more detail information, please refer to GT-530 User Manual.
Please be aware, The SMS Database System requires the .NET framensiank

2.0 to be installed on the target computer. Please follow the link below to get the
framework package directly from Microsoft, if required.

€ Download Microsoft .Net Framework Version 2.0
http://www.microsoft.com/downloads/details.aspx?FamilylD=0856each-43
62-4b0d-8edd-aab15c5e04f5&DisplaylLang=en

€ Download Microsoft .Net Framework Version 3.5
http://www.microsoft.com/downloads/details.aspx?familyid=333325FD-AE
52-4E35-B531-508D977D32A6&displaylang=en
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3 Software Installation
Please contact ICP DAS service to obtain the latest version of SMS Database

System setup file. Double click [SMS Database System Setup@i}o start

installation, click [Next] to continue.

{& SMS Database System

Welcome to the SMS Database System Setup
Wizard

The installer will guide pou through the steps required to install SMS D atabaze System on your
computer.

WARMNING: This computer program is protected by copyright lav and international treaties.
Unautherized duplication or distibution of this program, or any portion of i, may 1esult in ssvers civi
of criminal penalties, and will be prosecuted to the maximum extent possible under the law.

On [Select Installation Folder] page, input path or browse through file dialog box
to select the destination folder, click [Next] to continue.
i SMS Datubase System E‘@

Select Installation Folder

The installer will install 5M5 [ratabase System to the follawing falder.

Toinstallin this folder, click "Next". To install to a different folder, enter it below or click "Browse',

Folder

CAICPDASSMS Database Systern) Browse.

Install Sk3 Database System for yourself, of for anyone who uses this computer.

) Evempone
(&) Just me

[ Cancel ] { < Back ] [ hent>

Click [Next] to start installation.

{5 SMS Database System

Confirm Installation

The ingtaller is ready ta install SMS Database System on pour compiter,

Click "Next" to start the installation,

Concel | [ <Back | [ Hews
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When the installation process is completed, click [Close] to finish installing
program.

i@ SMES Database System

Installation Complete

SMS Database System has been successhully installed

Click "Close” to exit.

Pleaze uze Windows Update to %Ck for any critical updates to the \MET Framewark.

After the installation is completed, you will find SMS Database Systemcsihort

(icon Eﬂ) in the program menu: [Staf}] [All Programs}> [ICPDAS]
->[ SMS Database System]; click [SMS Database System] shortcut under the

[SMS Database System] category to start the program.

- s
E o Windows Catalog

% Windows Update

@) meastwmpRmE

I Evemote 3 ¥ 5 Uninstall K
9 XHD ¥ ([ Expreso 4
Bl - [ FileZilla FIP Client v
5 B RS " @ Fiezille Server v
@ S wEo » () JetBrains dotTrace 3.1 v
2 [ Microsoft Visual Studin 2005 »
o 0 SAREEW u‘:j PDFCreaior ks
o B @ HBEAE v
o 3

If the software isn't Lite version, in order to execute the software,egpgired to
plug Hardkey (provided by ICP DAS) into USB port.
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4 User Interface Introduction
SMS Database System user interface window contains the following areas

® [Menu Bar] and [Tool Bar]: contain menus and buttons for easy access
to functions.

® [Message List]: displays list of received messages (includmalar
messages and real-time messages periodically sent by remote units).

® [Status Panel]: shows messages processing status and connection
status.

® [Output Panel]: Display information, warning, error messages when
program execute.

Project Setting Record Wiew Tools Help
Y=lalkst Menu bar & Tool bar

L

rocessing Status |
| Unprocessed SMS #

r

Communi
GTM-20

pued snies

achine ) .,(—" =%
S M essage L ist £i)

Initial

Database

=0

Initial

Date / Time Message

Output Panel

Mo Project Opened |
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5 System Operation Procedure
It's easy to build a ready-to-use application on SMS Database System. Falow t
steps below to build an application:

Create a New Project

Com Port Setting

Phone Number Setting

Database Setting

Save SMS Message to Database

Display Historical Data

L 2R 2K 2R 2% 2R 4

5.1 Create a New Project
Follow the steps below to create a new project:
I.  Select [New Project] from the dropdown list of the [Project] menu,
the [New Project] window will pop up.

’_, SME Database System

Project | Setting  Record  Wiew  Tools

| Dew Project... L\@J :
: e

Open Project. ..

Exit

ii.  Input project name, input path or browse through file dialog box to
select the destination folder, click [OK] to create a new project.
New Project E‘

Installed Templates

Databasel ogger

Default Project

A project for database manager
Mame: NewProject

Location | C:Yy

Wil Create; C:l\MewPrajectifewProject. dproj

After the new project being created, you will find two notes
[Periodic Report Group] and [Alarm Event Group] appear in
[Message List].

nttp://www.icpdas.com 5
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®, SMS Database System - SMSDBTest

Project Setting Record View Tools Help

@O0 B X

Mgk Processing Status
Periodic Report Group Unprocessed SMS #

Communication Stal
GTM-201 Modem

L
- C \
‘4 Alarm Event Group ~:,ue»'
Initial

Database

-
=0

Initial

Date / Tirne Message

D:\TestCase\SMSDBETest\SMSDBT est. dprol Mo Active Database

The received SMS messages will be listed under the group it belongs
to. The description of the two group are as below
€ Periodic Report Group displays recent received periodic
SMS message.
€ Alarm Event Group displays recent received alarm event
SMS messages.

5.2 Com Port Setting

The database receives SMS messages transmitted by GT-530 via GTM-201.
Therefore, to communicate with GTM-201, it requires setting up the COM
Port parameter for the target computer.
Follow the steps below to set up the COM Port parameter for the target
computer:

i. Select [GTM-201 COM Port] from the dropdown list of the [Setting]

menu, the [COM Port Setting] window will pop up.

., SMS Database System - SMSDBTest
Sefting | Record  MWiew Tools Help
Database Properties
| GTM-201 COM Port %}
(3T-530 SIM Card Phore Numbers

Auto Load Recent Project

Project

Machine I[

Peri

nttp://www.icpdas.com 6
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ii. Selectthe COM Port to connect to GTM-201 from the dropdown list,
click [OK] to finish COM Port setting. To select appropriate COM
Port to connect to GTM-201, please refer to GTM-201 manual.

COM Port Sefting X

GTM-201 Modem COM Setting

COM Port: -

Baudrate: 115200

Data Bits: 8

Parity: None
Stop Bits: 1
[ (o] 4 ] l Cancel ]

5.3 Phone Number Setting

The Phone Number Setting function allows you to receive SMS messages

sent by authorized senders only; the filter function will prevent the database

from receiving and storing messages from unknown sendtersL (fe

version, the filter list function is limited and allows to setting up 3 numbers

at most)

Follow the steps below to set up filter list:

I. Select [GT-530 SIM Card Phone Numbers] from the dropdown list

of the [Setting] menu, the [SIM Card Phone Numbers Setting]
window will pop up.

. SMS Database System - SMSDB Test
Project | Setting | Record  Wiew Tools Help

Q) Database Properties
= 5TM-201 COM Port =

Ma':,':;l GT-530 SIM Card Phore Numbers |
Auto Load Recent Project

il. On SIM Card Phone Numbers Setting Pages, Check the [Enable
Phone Numbers Filtering Function] check box to enable filter
function.

nttp://www.icpdas.com 7
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SIM Card Phone Numbers Sefting 3

Please Input the GT-530 SIM Card Phone Numbers
in the table below:

¥:Enable Phone Numbers Filtering Function:
GT-530 SIM Card Information

Phone Number:

| | [ Dok |

iii. Input the allowed phone number in text box, Click [Add] button.
5T-530 5IM Card Information

Phone Number: (0945123455

| oadd | [ Delets

Phone Number List
0945123455
0945123458
0945123457
0945123456

. ciick T button to save filter list.

V. Please note: To avoid possible error, make sure the format of the
phone numbers you input are exactly the same as the format of the
phone numbers the sender source is going to send out. For example,
if the sender source will send out the numbers in the format that
will include area code or country code, make sure you add these
codes to your phone numbers on the list. These codes will not be
added to the numbers automatically.

5.4 Database Setting
The GT-530 SMS messages received by GTM:&ililbe stored in the
database. Therefore, it requires setting up the database before starting t
transmit messages. Currently two types of database is supported: MS SQL
Server 7.0 (or above) and MS Access 2008r (ite version, the type is
limited and allows to supporting MS Access2003.

Follow the steps below to set up database:
I. Select [Database Properties] from the dropdown list of the [Setting]
menu, the [Database Properties] window will pop up

nttp://www.icpdas.com 8
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®, SMS Database System - SHSDBTest

Setting | Record  Wiew Tools Help

| Database Properties N

GTM-201 COM Port gl

Machine Il -~ 530 51V Card Phone Numbers

Peri

Auto Load Recent Project

On [Database Properties] page, selkeetdppropriate database type.
If you select [None], the received SMS messages will not be stored
in database, but still will appear on the [Message List].

Database Properties ﬁl

[Primary] Database Communication Configuration
Datakase Type
(i None () MS Access () MS SQL Server

If you select [MS Access] as your database, complete and verify the

following settings:

Database Properties X
[Primsry] Datsbass Communication Configuration
Datakase Type
) Hone (&) MS Access O MS SQL Server

Apress Database Communication Configuration
Database name = | SMSDETest Size limit © (2048 w |MB

Ms Aecess file will ke namned by database name plos datetine,
Ertarnple: ke + 200700 02030405 (2007172 3:4:5)

When file size exceeds pre-set valve, | If both vnchecked, reoording will stop.
create new database

[ wpdate old records
Min HD free space less than 1 ME, delete old datakase
update old records
Location = |DASMEDETesy

Database name: Type a name for database. Current date (year,
month, day) and time (hour, minute, second) will be automatically
pasted to the name you type as the final database name. For
example, you type “abc” as database name, the database creation
date and time is “2007/01/02 03:04:05 "(the 24 hours time system),
the full database file name saved in system will be:

nttp://www.icpdas.com
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abc20070102030405.mdb

® Size limit: Specify maximum MS Access database file size atlowe

® Choose one of the following policies to apply when the database
file reaches its limit size:
[Create New Database]: The system will automatically genarate
new database (in the name of original input name pasted current
time tag) to store new incoming SMS messages.
[Update Old Records]: Once the file size reaches the specified limit,
the oldest data will be deleted to release space for storing latest
received SMS messages.
Default selected option is [Create New Database]. Please note: if
you uncheck default option without selecting another option, that is,
no policy is selected; the incoming new SMS messages will not be
stored in the database.

® Specify minimum “free disk space” allowed. You can also specify
which policy to apply when reaches minimum “free disk space”.
Two policies are available:
[Delete Old Database]: if [Delete Old Database] is checked, the
oldest database file will be deleted.
[Update Old Records]: if [Update Old Records] is checked, the
oldest data will be deleted to release space for storing latest
received SMS messages in current database.
If both policies are selected, [Delete Old Database] has higher
priority and will be executed first.

® Location: specify database storage location.

iv. If you select [MS SQL Server] as your database server, complete and
verify the following settings:

nttp://www.icpdas.com 10
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[Primary] Datsbese Communication Confizuration
Databaze Type
© None O MS Access ©MS SOL Server

SOL Database Comrmunication Configuration
Databese name © | epmns_ope

TP Addess 2.0 .0 .1
Fort Nuraker ©
User Mame - |sa

Password 1 | Wbk

[Backvp] Database Communication Configuration
Databaze Type
&) None () MS Access O MS SQL Server

® Database name: type in the name of the remote database to specify
which database you are going to store SMS messages. Please note:
the remote database you select has to be an already exist file on the
remote server.

IP Address: input the IP Address of the remote database server.
User name: input the login name to login remote database server.
Password: input the password to login remote database server.
Backup database: specify backup database for storing SMS
messages when experiencing unexpected disconnection and lost
connection to remote database server. Input backup database name,
IP Address, login name, password of the backup database.

v. Click [OK] to finish database setting.

5.5 Save SMS Messages to Database
After finishing database settings, now you can connect to database and start
to save SMS messages received in the database.
Follow the steps below to save SMS messages to database:
i.  Select [Start] from the dropdown list of the [Record] menu, or click

nttp://www.icpdas.com 11
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Q button on [Tool Bar].

®, SMS Database System - SMSDB Test
Project Setting | Record | Wiew Tools Help

Machine ID
Periodic Repor{

If receives SMS messages, the Machine ID of the received messages
will be listed on [Message List] panel under the category it belongs
to.

Mechine 1D

= 44 Alarm Event Group
=-"% GT-530-ST-666
GT-530-5T-666

= % GT-530-ST324
GT-530-5T324
GT-530-5T324
GT-530-5T324

i GT-530-5T324
GT-530-5T324
GT-530-5T324

Select [View>[Real-time Monitor View}>»[Open Data Monitor] or

click the button on [Tool Bar], the detail information of each

SMS message received will be listed on the [Message List] panel.

Wiew | Tools Help
| Realtime Monitor View  » | Open Data Monitor [?[
4 History Databaze View

Mechine ID Alarm Message Report Date Time
= i Alarm Event Group
= "s: GT-530-5T-666 DI9 Triggered!! 2009/10/09 09:12:02
- GT-530-5T-666 DI6 Triggered!! 2009/10/09 09:11:55
= s GT-530-5T324 DIS Triggered!! 2009/10/09 09:07:33
- GT-530-5T324 DI6 Triggered!! 2009/10/09 09:09:36
- GT-530-5T324 DI7 Triggered!! 2009/10/08 18:39:36
- GT-530-5T324 DI9 Triggered!! 2009/10/08 18:39:29
GT-530-5T324 DI8 Triggered!! 2009/10/08 18:39:23
- GI-530-5T324 DI9 Triggered!! 2009/10/08 18:36:24
- GT-530-5T324 DI6 Triggered!! 2009/10/08 18:36:11

To stop saving SMS messages to the database, select [Stop] from the

dropdown list of the [Record] menu, or cIi(O button on [Tool
Bar].

nttp://www.icpdas.com 12
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5.6 Display historical data
Historical data can be retrieved from the database. Specify the database
source and set conditions which is used to select the desired SMS messages,
the message list of your choosing will be display on the [Data List] panel
(apply to MS Access database only).
Follow the steps below to display historical data:
I.  Ifits recording status is not set to “Stop”, please select [Stop] from
the dropdown list of the [Record] menu, or clio button on [Tool
Bar] to stop SMS messages saving.
ii.  Select [View Database] from the dropdown list of the [View] menu

or click si'kbutton on [Tool Bar] to open the [Database View]

window. Later you can specify database source and select messages
to display from the left side panel.

Wiew | Tools Help

I Realtime Monitor View ¢

:| View Database N !

2009/11/6 2009/11/6
17:02:40 17:04:20

[ Export as Excel file I [ Export as Text file ]

Select Database File:
iil. Click [Browse] button, specify the database wer mokez00a1009165428m¢ v

source (MS Access database only) and opengmp o
the database file. Message Group list of the [ s
database will be displayed ( CRPT (Counter giﬁ;ﬂw
Report) group or ALARM group) in the left

GT-520-3T-666

Slde pan6| ije Session: )
zntllgnlofs IIIII 2059/15/9
18:38:00 ® 09:15:00
iv. ~ Click on the group of your choosing, the =

hitp://www.iIcpdas.com 13
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Machine ID of all messages under this group and the duration of
messages received time will be displayed.

v. Specify the time session of you choosing, click [Load Data] button to
load historical SMS message data.

# Datubase View

Select Database File: | Browse Data List (2) - CRPT }

|New Project20091009165428.mc ~| || [ Recording Tine | MochinelD | DI DIt DIz DI3 DI4 DI5
Group List: 2009/10,08 18:38:00 ‘GT-S}D-STEZA 1 |1g |1u3 1005 |1uuue |1num1
Group Home Gronp Definition 220094009 091500 GT-530-5T-666 1 19 103 1005 10008 100011
» Period Report Gro
ALARM ke Event Group

Machine ID List:
Checked | MachinelD

G- 24

G T-530-3T-666

Time Session:

RN

200011048 2009410/
18:32:00 i 09:15:00

[Exporl as Excel file I [ Export as Text file I

vi.  Click on the [Export...] button, the historical data of your choosing
can be exported into Excel or text format file.
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